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Figure 7-J: Choosing a Template

4. Select the template for the GM label you want to design, and click Next.

5. Click Finish when the summary screen is displayed, or click Back to

change any selection.

Note: Some of the library of templates listed have printer names

associated with them. Choose a template from the template list that

matches the printer previously chosen.

The template for the label is displayed in design view.
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Figure 7-K: GM Label Template

6. Continue creating the PDF417 bar code using the GM Bar Code Wizard:

GM Wizard, Part 1: Getting Started

From Loftware design mode:

1. Select Insert | Bar Code Wizard from the Design menu.

2. Select GM/HIBC/TLC39 Bar Code Wizards from the list of available

wizards, and click Next.
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Figure 7-L: Wizard Data Structure Screen

GM Wizard, Part 2: Building the GM Data Structure

1. Select PDF417 from the Symbology List, and click OK. The first dialog

box, regarding Kanban information, is displayed.

Note: Kanban is a term used to describe the flow process in Production

Ordering. Kanban specifies the item and the production quantity, the

materials required, where to find them, and where to store the finished

item.

Note: If you make an error in selection, click the Back button on the GM

Bar Code Wizard, and make the correct choice.
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Figure 7-M: Kanban dialog box

2. Select Yes or No, and click Next.

l If Yes is selected, the Container Type dialog box is displayed.

Note:What is Container Type? Container type information is a descriptor

of the actual container that holds the parts. The descriptor should match

the designated container type within the GM Plant(s).
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Figure 7-N: Container Type Dialog Box

l If No is selected, the Reference or PO Information dialog box is

displayed.
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Figure 7-O: Reference or PO Information Dialog Box

4. Select Yes or No, and click Next.

l If Yes is selected, the Field Name dialog box is displayed.

l If No is selected, the Container Type dialog box is displayed.

5. From the Field Name dialog box, enter a Field Name, or accept the

default name, and click Finish.

6. From the Container Type dialog box, select Yes or No, and click Next.

The Field Name dialog box is displayed.

7. Enter a field name, or accept the default name, and then click Finish.
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GM Wizard, Part 3: Finishing and Printing the Label

After you have entered a name for the label and clicked Finish, the field is

placed on the label in the upper left corner. Use the cursor or the keyboard

arrows to move the bar code field into place at the upper right corner of the label

(for GM1724-A labels, as shown in this section).

The completed GM Label, with the PDF417 bar code in place, is shown:

Figure 7-P: GM label, with PDF417 Bar Code Inserted

You can print this label using Loftware technology such as:

l On-Demand Print Module

l The Loftware Print Server Technology

Or, from other Windows Applications using:

l Loftware's ActiveX Controls, or the Thin Clients

l Loftware’s Internet Printing Applications

Note: You may have to make changes on the On-Demand Print Form to

configure any non-printing fields you may have.
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Advanced Information

GM Formula Data

Double clicking on the newly created bar code displays the formula created by

the Loftware GM Wizard:

Figure 7-Q: Formula Dialog Box

Data Fields

The following data fields are included in the PDF417 symbol on the GM-1724-A

label:

Note: “*” Indicates a required field, however, this is subject to change

by General Motors without notice. As suggested previously, verify all GM

specifications with GM.

Part Number*
Part Quantity*
Kanban
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Reference
Purchase Order
Plant/Dock*
License Plate*
Material Handling Code*
Container Type (Recommended)
Weight (Recommended)

Note: The License Plate field is a combination of the supplier ID,

combined with the supplier generated ship pack serial number.

GM - Additional Components

In addition to the data fields, there are additional components that are required

by GM for processing of the label. These components are detailed in the

following table:

Component
Fixed

Data
Function Variable Data Field Name

*Compliance Indicator [)>

*Format Trailer RS()

*Format Header 06

*Part Number Data ID P

*Part Number Part_Number

*Data Element Separator GS()

*Quantity Data ID Q

*Ship Qty Quantity

*Data Element Separator GS()

Kanban Data ID 15K

Kanban Reference

Data Element Separator GS()

Reference Data ID K

Reference Reference

Data Element Separator GS()

*License Plate Data ID 1J

*License Plate ASSIGN_AUTH & DUNS_NO & SERIAL_

NO

*Data Element Separator GS()

Material Handling Code Data

ID

20L

*Material Handling Code Mat_Hand_Code

Data Element Separator GS()

Container Type Data ID B

Container Type Container_Type
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Component
Fixed

Data
Function Variable Data Field Name

Data Element Separator GS()

Weight Data ID 7Q

Weight Weight

*Weight Qualifier GT

*Format Trailer RS()

*Message Trailer EOT()

The functions from the table above result in the encoding of the following

characters into the symbol:

Function Hex Decimal

GS() 1D 29

RS() 1E 30

EOT() 04 04

Related Information

Refer to the printing sections in this guide, and The Loftware Print Server,

Thin Clients, and Internet Printing in the Loftware Print Server User’s

Guide to review how to print this label.

UPN Healthcare Wizard

l Allows the creation of all UPN-approved bar codes, including: HIBC Code

128, HIBC Code 39 and UCC/EAN128

l Allows automatic merging of bar codes to meet UPN specifications

l Allows automatic insertion of flag characters and check digits required for

healthcare industry bar codes

l Supports UPN-approved data structures

This section walks you through the entire bar code creation process using

Loftware’s Bar Code Wizard. Instructions include how to:

l Create Primary, Secondary, or Combined bar codes for your label file that

require UPN (Universal Product Number) bar codes.

l Create other sophisticated bar codes using the Loftware Bar Code Wizard.
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UPN Bar Code Options

Loftware Label Manager and the Loftware Print Server use the Loftware UCC

Bar Code Wizard to help create bar codes that comply with the UPN

specification for both the UCC and HIBC. The wizard walks you through a series

of screens asking specific questions about the information you want in your

Primary and/or Secondary bar code.

The bar codes contain these options:

Option Description

Primary Labeler Identification Code, Manufacturer ID, Product/Catalog Number, and Unit

of Measure.

Secondary Information such as Lot Number, Quantity, and/or Date.

Combined Combines the Primary and Secondary information into one bar code.

The questions you answer automatically create a formula that produces the bar

code for your label.

Creating a Primary and Secondary LIC Bar Code

UPN Wizard, Part 1: Getting Started

l Open the Bar Code Wizard

l Choose UPN

To get started

1. Click Start | Programs | Loftware Labeling | Design 32. A blank label

on the left side of the screen and a blank Properties Box on the right side

are displayed.

Note: If you do not see the Properties Box, use the View | Properties

menu command to display it. If you do not see a blank label, select the

File | New menu commands and create a new label. To adjust the label

size, use the File | Media Setup menu command.

2. Select Insert | Bar Code Wizard menu at the top of the screen.

3. Select GM/HIBC/TCIF Bar Code Wizards from the list of available

wizards, and click Next.
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UPN Wizard, Part 2: Building A LIC Data Structure

l Create a LIC Primary Bar Code.

l Learn about Data Structure Screens.

l Add specific and optional information to a Primary Bar Code.

To build a LIC data structure

1. Select UPN Wizards at the end of the Data Structure list. The first Bar

Code Wizard dialog is displayed.

2. Click Primary.

UPN Wizard, Part 3: Creating a Primary Bar Code

To create a primary bar code:

1. Select the LIC option from the Data Structure screen.

2. Select the bar code symbology you want to use.

Figure 7-R: Symbology selection Screen

If this is the first time this symbology has been selected, the following screen is

displayed:
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Figure 7-S: Labeler Identification Display Screen

3. Type in a New Entry, (Example: A234), and the Entry Description

(Example: ‘Flag Character’), and click OK.

4. Select the Labeler Identification Code from the box, and click Next.

Note: To add another identification code, click Add New Entry and

follow the instructions on the screen. To delete a code, select the

Identification Number and then Click Delete Entry. Warning! Once you

delete the ID, you cannot undelete!

The following screen is displayed:
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Figure 7-T: Product/Catalog Number dialog box

5. Select Yes or No, click Next.

l Selecting Yes allows you to enter the part number at print time

from the keyboard (On-Demand printing) or a database (Range

Printing).

l Selecting No allows you to enter the part/catalog number on the

next screen. You do not have to enter the part/catalog number at

print time.

6. Type in new values for Field Name and Length or leave the default

values in place, and click Next.
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l If No is selected, the next dialog box prompts you to enter a

Product Number.

7. Enter up to 13 digits, and click Next.

The Unit of Measure ID screen is displayed.

Figure 7-U: Unit of Measure ID at Print time Dialog Box

8. Select Yes or No, and click Next.

9. Enter a field name for Unit of Measure, and click Next.

10. Enter a Unit of Measure value (see below), and click Next.

0 = unit of use 5 = case

1 = unit of sale 6 = reserved

2 = reserved 7 = master case
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3 = carton 8 = reserved

4 = reserved 9 = variable quantity container

11. Enter a name for the Primary bar code, and click Finish.

Note: If data is entered from a keyboard or database for non-printing

fields, select On-Demand Print Form from the View menu, or click the

Customize On-Demand Print icon from the toolbar. Then, DOUBLE-Click

each field to change its data source.

You may see the following screen (after adjusting the fields) depending on your

choices:

Figure 7-V: Primary Field Creation

UPN Wizard, Part 4: Creating a Secondary Bar Code

You can create a LIC or a UCC/EAN Secondary Bar Code containing information

such as Lot Number, Quantity, and/or Date. This example allows you to:

l Create a LIC Secondary bar code

l Learn about data structure screens

l Add Julian date

l Add Lot Number

Loftware LabelManager 9.6 User Guide330



Bar Code Wizards

To create a Secondary Bar Code

1. Follow the steps from UPN Wizard, Part 1, in the preceding section.

2. Select and press the UPN Wizard button. The following is displayed:

3. Click the Secondary button; select LIC as the Secondary bar code data

structure, and click Next.

4. Select the bar code symbology you want to use, and click OK.

The following screen is displayed:

Figure 7-W: Selecting the HIBC Flag Character

5. Select the flag you want to use, and click Next.
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UPN Wizard, Part 5: Create a Bar Code with Julian Date and Lot Only

Creating an Expiration Date in Julian format and a Lot/Batch

number in the bar code:

1. Select the Symbol to encode, “Only the Julian Date” and “Lot Number”

(+), and click Next.

2. Enter a field name for the date.

3. Enter the number of days until the product expires, and click Next.

Example

If the product expires in one year, enter 365. The date printed on the

label is one year from the day the label is printed.)

Figure 7-X: Lot Field Creation
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4. Enter a field name and length for the Lot, and click Next.

Figure 7-Y: Name Secondary Bar Code Symbology

5. Enter a field name for the Secondary bar code, and Finish.

Note: If data is entered from a keyboard or database for non-printing

fields, select On-Demand Print Form from the View menu, or click the

Customize On-Demand Print icon from the toolbar. Then, DOUBLE-Click

each field to change its data source.

The Secondary Bar Code is placed on the upper left corner of the label. Use the

mouse cursor, the Properties Box, or the arrow keys to move the new bar code

and the human readable field into place below the Primary Bar Code.
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Figure 7-Z: Secondary Bar Code placed on the Label.

UPN Wizard, Part 6: Create LIC Secondary Bar Code with Lot Only

For a product with a secondary bar code and lot only:

1. Select +$ from the HIBC LIC Secondary Bar Code Creation dialog box7,

and click Next.

2. Enter a name for the Lot and a field length, and click Next.

3. Enter a name for the Secondary bar code, and click Finish.

Note: If data is entered from the keyboard or database using non-

printing fields, select the On-Demand Data Entry form from the View

menu, or click the Switch Views icon from the toolbar. Then, double

click each field to change its data source.

UPN Wizard, Part 7: Creating LIC Secondary Bar Code Using Other Data

Formats

1. Select +$$ (to encode other data structures) from the HIBC LIC Secondary

Bar Code Creation dialog box, click Next.

2. Selecting +$$ allows you to include Quantity, Date and/or Lot and Batch

Number on your Secondary Label. First, decide if you want to include a

Quantity on your label by choosing Yes or No.
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3. Select Yes or No and click Next.

l If No is selected, go to Step 5.

l If Yes is selected, continue with Step 4.

4. Select the 2 or 5 digit quantity format you want, and click Next.

l Select 5-digits (QQQQQ) if you are not sure which format you

want.

5. Enter a name for Quantity, and click Next.

Note: If you did not select Quantity, then the references to that field are

not in the Formula, Description, and Non-Printing Fields boxes.

6. Select Yes or No, and click Next.

l If No is selected, go to Step 9.

l If Yes is selected, a Date Formula dialog box is displayed.

7. Select the date format you want (scroll through the list for more options),

and click Next.

8. Enter a name for the date and the number of days until the product

expires, and click Next.

Example

If the product expires in one year, or 365 days, enter 365. The date

printed on the label is one year from the day the label is printed.

Note: If you did not select Quantity or Date, then the references to those

fields are not in the Formula, Description, and Non-Printing Fields boxes.

9. Enter a name for the Lot and a field length, and click Next.

10. Enter a name for the Secondary bar code, and click Finish.

Warning! Bar Codes and human readable fields are not validated on the

WYSIWYG screen. TEST print does not show your actual encoded data.

You must go to a Loftware Label Manager printing application such as

On-Demand or Range Printing to encode and validate your actual data.
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Templates and Wizards Summary

l Using pre-made templates from Loftware Label Manager

l Designing new templates for labels

l Utilizing the Loftware Bar Code Wizard to create bar codes

l The GM Wizard

l The UCC Code 128 Bar Code Wizard

l The UPN Bar Code Wizard
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